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Thanks for choosing to submit your order electronically to Wes-Tex!  We hope you will find electronic
ordering to be an efficient and easy way to get your project to us.  To help the process go as smoothly as
possible, Wes-Tex has some guidelines that should help you (and us) avoid some of the most common
problems that occur with placing orders via the Internet, bulletin board service, or disk.

In this guide you'll find step-by-step instructions for correctly preparing your files to be sent to Wes-Tex.
We've covered the most common and most popular software programs people use to create documents
like yours, so all you have to do is look for the section that applies to the program you've used.  If you
don't see the program you've used, that doesn't mean we can't handle your documents.  There's a section
on "Other Programs" that will let you know what to do.

Please note the "Electronic Order Checklist" at the end of this guide.  It's a handy reference to make sure
you've covered all the bases before you send in your order.

If you run into any problems along the way, please call Customer Service at 800-346-0515.

We look forward to receiving your order!

Using This Guide
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If you or your customers use QuarkXPress to create your files, Wes-Tex is
ready to handle them.  Before you send us your file, though, there are a few
simple steps you can take to help speed things along and avoid troublesome
delays (for you and for us).

Check the File to See if It's Ready to Send
The most important thing about sending files created in
QuarkXPress is making sure that copies of all the graphics and
fonts you've used are sent to us along with the Quark file.

When you've finished creating your document and everything
looks the way it's supposed to, you're ready to make sure all fonts
and links are in place.

If you are using version 4.0 of XPress, select Utilities, then
Usage , then Picture .  You should now be looking at a list of all
your images along with the status of each one.

If you are using version 3.3 or earlier, select Utilities and then
Picture Usage to get to the list of your images.

Is the status of each image listed as "OK"?  If so, then you should be ready to
go the next step…see Collect for Output below.

If the status of a file reads "Modified," then you need to select (highlight) the
name of the image and click on Update.  Here you need to be careful,
because on rare occasions QuarkXPress will change the position of a graphic
after you update it.  Check the layout of the graphic to make sure it's still in
the right place.

If a file is "Missing," you will need to find the image and tell Xpress where
to find it.  You do this by first selecting Update.   A window will open listing
the contents of your drive.  You need to locate the missing image files, select
them, and click on Open. You should then be returned to the Picture Usage
window, and the status of your images should read "OK."
Note:  the status of all images must read "OK" before you
can move on.

Collect for Output
Before going on, it would be a good idea to print a laser
copy of the document and make sure everything looks all
right.

The next step is to gather all graphics and the document file
and put them together in one folder. To do this, select File

QuarkXPress Files



EELLEECCTTRROONNIICC  OORRDDEERRIINNGG    3      

and then Collect for Output.  You'll need to create a new folder for all your
work where everything will be gathered.  In the "Save In" bar, select your
new folder, give it a name, and then choose Collect.

When collection is complete you should see a report for your file that lists all
the fonts used in the document plus any extensions that should go along for
the ride.  Now it is very important for you to see exactly which fonts are used
in your document and send them along in the folder, because "Collect for
Output" does not collect fonts.  Make sure you select all the fonts used and
copy them into your collection folder so that you can send them on to
Wes-Tex.

If you're not sure what fonts you've used, return to the Utilities menu
and go to Fonts .  This will give you a list of the fonts you'll need to
copy into your folder.  Be sure to copy all the fonts and styles listed,
even if they are variations on the same font.  For example, if you see
both Arial <P> and Arial <I> listed, you need to copy both styles.

Check to see whether the fonts are TrueType  or Type 1.  If a font is
Type 1, there will be two elements that you need to copy into your
folder and send to us:  the screen font (which often resides in a
suitcase) and the printer font.  (A TrueType font has only one
element.)

When you send your files to Wes-Tex, be sure to send all the files
located in the special project folder you created.

Once you have all the necessary files gathered in your folder, you're ready to
move to "Final Steps" (page 15).

Files Saved as .EPS
After completing a document with QuarkXPress, some people like to save
the file as an EPS graphic, which allows the file to be imported into other
applications (these files have .eps  as their extensions).

We at Wes-Tex prefer you not to save your files this way.  However, if you
have created a file and saved it as EPS, we can handle it.  It is still important,
though, that you send along the fonts with the file, because fonts aren't
embedded into EPS files.

If you don't send
the necessary
fonts along with
the document,
your order may be
delayed
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Adobe PageMaker has been a favorite tool of many printers and typesetters
ever since the beginnings of desktop publishing.  If you've used PageMaker
to create your documents, Wes-Tex can easily handle your files.  To make
things easier for all of us, there are some quick steps you can take before
sending your files that will get the ball rolling along smoothly and avoid
delays

First, open the file(s) you or your customers created and look everything over
to make sure it looks right on the monitor.  Print the file on a laser printer as
well.  If there are no problems, you're ready to move on!

Save for Service Provider
The next step is gathering everything together for shipment to Wes-Tex, and
luckily in PageMaker that's a fairly simple process.

First of all, you need to create a new folder where you can place all your
work.  This should not be the same folder where you save your original
Pagemaker document.  Once you've created a new folder for this job, go on
to the next step.

From your menu in PageMaker, go to Utilities, select Plug-
ins , and then choose Save for Service Provider.  (At this
point you may be asked to save your work before
continuing with Save for Service Provider.  If so, go ahead
and save the document, but do not save it in your new
folder.)  This convenient little utility not only collects the
primary PageMaker document and all your graphics and
fonts in one folder for simple transport, it "preflights" your
file to make sure you still have all the necessary graphics
and fonts loaded.

Now click on Preflight Pub and sit back while PageMaker
does the work.

When the process is complete, if you see checks beside the "Fonts" and
"Links" categories, you're set for the next step.  If not, that means
something's missing.  If you don't see a check, select the Fonts  or Links tab
(whichever doesn't have a check) and you will be given a list of what 's not
there.  Before going on, fix this problem by finding the missing elements.

It's also a good idea at this point to check the Printing and Inks tabs to make
sure the dimension and number of colors is correct.

PageMaker Files

If fonts or links
are missing, our
hands are tied!
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When all is well and ready to go, select the Package button
at the bottom left of the screen.  This pulls everything
together in one convenient folder for copying to
transportable media or e-mailing us directly.  You'll be
prompted by a Save As screen. In this window, before
saving your work, check the "Copy Fonts" option and then
select the "All" radio button beside it.  Next, click on the
box next to "Update links in source pub before packaging."
Now all you have to do is give your file package a name
and save it in the new job folder you created earlier.  Note:
A warning pop-up screen regarding copyright on Adobe
fonts may come up.  If it does, simply click on "OK" and
move on--Wes-Tex is authorized to use Adobe fonts.

By the way, when you save the package, you'll see a file called "Report"
that's now included in the folder.   It should be sent to us along with all the
other files in the folder.

When you're ready to send us your files, please see "Final Steps" (page
15).

Files Saved as .EPS
After finishing the document, many people choose to turn it into an EPS
graphic, which allows the file to be imported into other applications as if it
were any other picture.

However, we'd rather you not save your files this way as it actually can make
things more difficult for us here at Wes-Tex.  If you've already done so,
though, that's OK--we can still handle it.  Just be sure to also include all
Postscript and TrueType fonts or you'll be hearing from us with news that
your order has been delayed because we don't have everything we need.

Please be sure to
send us ALL the
files in your
folder!
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If you're using Adobe Illustrator to create your document, hooray for you!
Illustrator makes the process of preparing, sending, and working with
documents easier for all of us.  With just a few simple steps you can get your
document ready for us here at Wes-Tex and we'll be happily on our way to
processing your order.

Your goal (and our goal, too) with Illustrator is to convert your document
and save it as an Encapsulated PostScript (EPS) file.  Fortunately, Adobe
Illustrator makes this process fairly simple.

Converting to Outlines
First you want to make sure everything about your
document looks OK.  When you've finished creating
the document and you're satisfied with it, go to the top
of the screen and, under the Edit pull-down menu,
click on Select All.  Make sure that every part of your
document (graphics and type) is now selected.

Now go to the Type  menu and select Create
Outlines.  This should convert everything in your
document to outlines (artwork) so that all text is
treated as a graphic rather than type.  Before moving
on, make sure that this is the case.  If not, repeat the
process.

Saving as Illustrator EPS
Now that you're ready to save your work, go to the File menu and click on
Save As.  The "save" screen will appear and you'll be asked to name the file.
You will also see a "save as type" option, and there you need to select
"Illustrator EPS."  Once you've named the file, save it.

The document has now been saved as an EPS file, and all you have to do is
send this file on to us at Wes-Tex.  See "Final Steps" (page 15)

Adobe Illustrator Files

Sending us an
Illustrator EPS
file is the most
reliable way to
send in your
electronic order

…a project
converted to
outlines
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location of the
"Convert Text"
button

CorelDraw! is another great program for creating your document.  We'll be
glad to handle your Corel files.   CorelDraw allows you to export files and
save them in various formats.  To make things easier for all of us, we'd like
you to save your files in EPS (Encapsulated PostScript) format, which means
you won't have to send any additional files such as fonts or graphics.  To
export your file and save it as an EPS, just use the following steps.

Convert to Curves
When you have finished creating your document in
CorelDraw! and you are satisfied with the way everything
looks, the next thing you want to do is convert it all (text,
graphics, etc.) into artwork.  In Corel you do this by
converting to curves.

If you've used text in your document (and you probably
have), select the text area. Click on the Convert Text
button on the toolbar in the upper right corner of the
screen (or hit CTRL & F8 on the keyboard).  Do this with

each individual text area in your document.

Next, at the top of the screen, go to the Edit menu and click Select All, then
Objects .   Make sure that all parts of your document have been selected.
Next, go to the Arrange menu and select Convert to Curves.  This will turn
all text into graphic form rather than type. (If you happen to have any
problems selecting Convert to Curves, you may need to select each separate
area of your document individually, then go to Arrange and choose Convert
to Curves.)

Saving as .EPS
Next, go to the File menu and choose Export.  A
"Save" screen will appear, and here you need to make
sure that the "file type" you are saving is
"Encapsulated PostScript."  Give your file a name.
Click on Export, and another window will pop up
with more options.  On the "Export text as" option,
choose Curves.  No other checkboxes in this window
should be selected except "Convert color bitmaps to
grayscale." Now click on OK.

You're finished!  All you have to do at this point is
attach the EPS file you've created to an e-mail
message and send it on to us at Wes-Tex.  Please see
"Final Steps" (page 15).

CorelDraw! Files
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If you've used MacroMedia Freehand to create your document, Wes-Tex
should have no problems handling your files.  Like several other programs,
Freehand allows you to quickly and easily convert your document into an
Encapsulated PostScript (EPS) file, which is the most convenient format for
us here at Wes-Tex.  Just use the following steps, send us your file, and your
order will be sped on its way.

Convert to Paths
When you've finished creating your document and everything looks just the
way you want it, the next step is to convert all your text into artwork.  To do
this, first select your text area and then go to the Text menu at the top of the
screen.  Under Text, click on Convert to Paths .

Now you're ready to save your work as an EPS file.  Under
the File  menu, select Save As.  In the window that comes
up, look for the option box beside "Save as type."  Choose
"Editable EPS (*.eps)."  Now give your file a name in the
"file name" box and click on Save.

You're done!  When you're ready to send your file, please
see "Final Steps" (page 15).

 Freehand Files



EELLEECCTTRROONNIICC  OORRDDEERRIINNGG    9      

 Saving as an EPS file

Saving as a Photoshop file

Adobe Photoshop is one of the best choices for creating documents.   If
you're using Photoshop, hooray for you!  Wes-Tex can easily handle your
files.  Here are just a few simple steps to follow.

If all the artwork in your document is composed of bitmaps or grayscale
images, you will be able to save your file in Encapsulated
PostScript (EPS) format, which will make things a little
easier for us at Wes-Tex.  If you have no other artwork but
bitmaps or grayscale images, go to the File menu and
choose Save As.  In the "save" window that comes up, look
for the option box beside "save as."  Choose "Photoshop
EPS." (If "EPS" is not an option, then you have artwork
that is not bitmap or grayscale--RGB, for example--and
will not be able to save the file in EPS format.  Please see
the next paragraph.)  Finally, give your file a name and
save it.  Now you're ready to send us the document!  See
"Final Steps" (page 15).

If any of your artwork is not bitmap or grayscale, you
simply need to save the file as a native Photoshop file,
which is perfectly OK with us.  Under the File  menu,
choose Save As.  Beside "save as" you should see only one
option--"Photoshop." Native Photoshop files have either
.PSD or .PDD as filename extensions.  You need only to
give your file a name, save it, and get ready to send it on to
us at Wes-Tex.  When your file is saved and you're ready to
send it, please see "Final Steps" (page 15).

Adobe Photoshop Files
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Don't forget to send us your
fonts and graphics…please!

Microsoft Publisher is another popular software title that many people use to
create their documents.  If Publisher is your program of choice, Wes-Tex is
prepared to handle your files.  Just follow the simple steps described below
and your order will be sped on its way!

Font and Graphics Usage
As with many other applications, it is important with Microsoft Publisher
that you take the time to send all fonts and graphics you used in your
document.  Of course you will need to send us the native Publisher document
itself, but the fonts and graphics you use in your project may not necessarily
be embedded in the native file.  And that means if you don’t send them along
with the native file, they may not be there when we open your file here at
Wes-Tex.  So, once your document is completed and looks just the way you
want it, the first thing to do is make sure you know exactly what fonts and
graphics you've used.

To do that, go to the Tools  menu on the main toolbar
and select Commercial Printing Tools .  You'll have
three more options come up, including Fonts and
Graphics Manager.  First, select Fonts .  A window
will open showing you a list of the fonts you've used
in your document and also telling you whether the
fonts may or may not embed into your document.
Don't worry about the embedding part, because you're
going to send us all the fonts anyway, right?  Now you
just need to be sure that you send us all the fonts you
see listed.  Before you close this window, it would be
a good idea to also check the box labeled "Embed
TrueType fonts when saving publication."

Next, go again to Tools  and then Commercial
Printing Tools , but this time select Graphics
Manager.  The window that now opens gives you a
list of the graphics you inserted into your document.
Again, it's important to note all of these and send them
along with your native file.  By the way, the lower left
corner of this window should also tell you the Path
where the graphics are located.  When you're finished
with this information, close the window.

Microsoft Publisher Files
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Save Your Native File
Now you're ready to save your project and send it on to us
(along with the fonts and graphics!).  Go to the File menu
and select Save As.  In the save window that opens, you
just need to give the file a name and make sure you save
it in the folder of your choice (or on diskette, of course).
Check to make sure that the file type beside "Save as
type" (underneath "File name") reads "Publisher Files."  It
is not necessary to give your file name an extension,
because Publisher automatically places a ".pub" extension
on all native Publisher files.

Now you're ready to send everything to us!  Please see "Final Steps" on
page 15.

What about Creating an EPS File?
Some people like to save their documents in EPS (Encapsulated PostScript)
format because they think it will be easier for printers like Wes-Tex.  If
you're using Microsoft Publisher, we really, really would rather you not try
to send us an EPS file. It is actually easier for us if you send a native
Publisher file.  However, if you're determined to send an EPS file (and know
how to do so), please remember to also send us all fonts and graphics used in
your document.  Otherwise you may be hearing back from us with news that
we don't have everything we need.
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Some applications that you may use will have the ability to create Adobe Acrobat PDF files from
your documents.  Wes-Tex does not encourage you to send PDF files, but if you know how create
them, we can take them.  Just be sure that you embed all fonts  and that you do not use any
compression.  If you have any questions or need additional help, feel free to call us at 800-346-
0515.

Wes-Tex recommends that you use one of the programs covered in this manual to create your
document.  We can't guarantee that we'll be able to handle files created with other applications, but
we will definitely give it a shot.  If you've used something other than one of the programs we've
listed, the best thing to do is to send us everything you used to create the document, which could
include the following:

l   Fonts .  Be sure to send us all fonts you used, including variations
    of the same font  (for example, if you used the bold or italics font
    in addition to the plain font itself, send them all).

l  Graphics.  Be sure to send all graphics you included in your
          document.

l  Native File.  Of course you need to send the actual document file
    itself, as created and saved in whatever application you've used.

It might also be helpful to see if you can print your document into a postscript or PDF file.  If you
can, send that file as well.  If we cover enough bases, we'll increase our chances of handling your
document without too much trouble.

Adobe Acrobat PDF Files

Other Programs
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Wes-Tex has created our own templates and we encourage you to use them.
These templates have been created and saved using the following
applications:

CorelDraw! 7.0
Adobe Illustrator 8.0
Adobe PageMaker 6.5
Quark XPress 3.3
Quark XPress 4.0
MacroMedia Freehand 7.0

If you're using a different application but want to try to send in a postscript (ps) or portable
document (pdf) file, the following printing areas and measurements are required.

Printing Area of: Actual Paper
Size*

Standard
Printing Area*

Maximum Oversize
Printing Area*

Business Card
l Standard Business Card 254 x 144 216 x 114 242 x 134
lVertical Business Card 144 x 252 114 x 216 134 x 242
lFoil Maximum Oversize 252 x 144 234 x 126 234 x 126
lInk Maximum Oversize 252 x 144 240 x 132 242 x 134
Stagger Foldover **
lFront 252 x 117 216 x 117 242 x 117
lTop Inside 252 x 117 216 x 117 242 x 117
lBottom Inside 252 x 144 216 x 144 242 x 144
lBack 252 x 144 216 x 114 242 x 134
Stationery
lStandard Letterhead 612 x 792 540 x 729 540 x 729
lProfessional Letterhead 522 x 756 450 x 693 450 x 693
lStandard Envelope 686 x 297 632 x 243 632 x 243
lProfessional Envelope 540 x 279 486 x 225 486 x 225
Commercial Announcements
lBaronial 400 x 308 318 x 224 318 x 224
lBaronial Envelope 400 x 308 216 x 72 216 x 72

*Paper sizes and printing areas are shown in points for measurement.
**For the backside of a Stagger Foldover, you may use any of the standard business card
dimensions.

Using Templates
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Some of your graphics may be images that you have scanned yourself.  In order to produce high-
quality images that will make your project look its best, please follow these guidelines.

Line Art
Line Art could include text, logos, or clip-art images that contain only black and white.  To
ensure image quality, it is important that line art be scanned at a higher resolution than what is
required for photographs.  Wes-Tex recommends that you scan line art at a minimum of 600
dpi, but you will get better results if you scan at 1200 dpi.

Photographs
You should of course scan photographs as grayscale images, so photographs should therefore be
scanned separately from any line art you plan to scan and use.  We recommend you scan
photographs at a minimum of 300 dpi.  Make sure that when you save the image, you save it as
grayscale.

If you're going to enlarge the image you're scanning, do not scan it at its original size and then
plan on blowing it up, because you will lose resolution and the image quality will be poor.  You
will not be happy with the results!  Scan the image at 100% or more of the intended enlarged
size.  For example, if you have an image that is an inch wide and you want it to be three inches,
scan at 300%.  It's always better to scan too large than to scan too small, because we can reduce
an image with no loss in quality, but you're guaranteed a loss if you blow up a lower-resolution
scan.

You may send scanned images to us in TIFF (uncompressed) or EPS form.

Scanning Images
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Okay, you've got your document ready to go--now you're ready to send it on to us.  All you have to do
now is take the following steps to help make the Electronic Ordering process move as smoothly and
efficiently as possible.

Proof Your Document
Although we try to check for spelling, correct abbreviations, mechanics, and so on, please carefully
proofread everything on your end to make sure you haven't overlooked any spelling or typographical
errors.

Compressing Your Files
It might be a good idea to compress your files, which will speed up sending and uploading time.
Compression is also a good way to keep files together in one place during transmission.  Be careful,
however!  If you over-compress, we'll have problems and you won't really be saving any time.
Occasionally we've received ".sit" compressed files with file sizes of 0KB!  We recommend using the
following programs for compression:  WinZip for PC or Stuff-It or DiskDoubler for Mac.  Also for Mac
you can create a Self-Extracting Archive file.  Beta versions of these programs are available on the
Internet at little or no cost, so consider using them.

Transmitting Your Files
Now you're ready to attach your files to an e-mail message addressed to us.  In your e-mail, please
include the following:

l  Your alphabetical dealer number
l  Your company name
l  Your name and phone number
l  Name and phone number of person to contact regarding
    problems
l  Your Purchase Order Number, if applicable
l  Type of product ordered
l  Ink(s), screen values, foil color
l  Stock
l  Quantity
l  Platform used (Mac or PC)
l  Application used and version number
l  Shipping Information
l  Additional Instructions
l  Margin specifications (if necessary)

If you include this information, there should be no delays unless we encounter problems with your files.
After you send this e-mail message along with your attachments, you should receive confirmation via e-
mail stating that we did receive your order and that it has been entered for preflight.  If there are any
problems or questions, a customer representative will contact you.  If you receive this e-mail
confirmation, you do not need to call to check if we received your order.

Finally, please fax us a composite of your file (toll free 877-361-1810).  After you create your file and
have saved it as you want it to look, print a copy and fax us that proof.  This way we can make sure our
output matches yours.

Final Steps
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o Design your document.  Always use the page size of the actual product for your file.
For example, if you were designing a standard business card, you would define your 
size as 2 X 3.5 inches.  This will save some time in converting your files and will help
maintain the margins you want on your card.

o Save your document.  When you have designed your card, letterhead, etc., save 
it to a place you can easily find.  It would be a good idea to save the document in 
its own directory along with copies of any graphics, fonts, or other relevant files 
used in the creation of the document.

o Print a composite sized at 100% (showing crop marks if possible).

o If you choose to do so, compress your files using a compression tool such as 
WinZip for PC or Stuff-It for Mac.

o Create an e-mail message and address it to us at order@wes-tex.com.  In the 
subject line, type your company name.  (See "Final Steps" for other information
needed in your e-mail message.)

o Attach your compressed file to your e-mail message.

o Send us your e-mail.  After we download your file, we will send you an order
confirmation via e-mail.

o Fax us the composite you printed.  Fax to the Electronic Ordering Department at
(toll free) 877-361-1810.  Please indicate any special instructions, such as
specific margin requirements, bleeds, or color separations if applicable.

Electronic Order Checklist


